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Pulau Tegal memiliki potensi dan keanekaragaman wisata bahari yang 

menjadi daya tarik bagi wisatawan. Namun, belum tersedia informasi 

yang dapat membantu wisatawan dalam mengetahui objek dan kawasan 

wisata yang terdapat di Pulau Tegal.  Penelitian ini menyajikan informasi 

wisata yang ada di Pulau Tegal ke dalam bentuk peta Sistem Informasi 

Geografis.  Metode pemetaan yang dilakukan menggunakan perangkat 

lunak Quantum GIS dengan bantuan plugin QuickMapServices (QMS) 

untuk menampilkan citra Google Earth dan plugin qgis2web untuk 

mengkonversi file QGIS (.qgz) menjadi peta web (WebGIS) serta adanya 

input indeks wisata.  Hasil pemetaan didapatkan digitasi dari setiap objek 

dan fasilitas wisata di Pulau Tegal ke dalam bentuk shapefile (.shp) serta 

informasi ditampilkan pada attribute table layer.  WebGIS digunakan 

sebagai media penyaji peta SIG yang mudah diakses dan disesuaikan 

tampilannya dengan library JavaScript Leaflet (open source).  Peta Sistem 

Informasi Geografis memberikan kemudahan bagi masyarakat dalam 

menyampaikan dan mencari informasi wisata di Pulau Tegal. 
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Tegal Island has the potential and diversity of marine tourism which is an 

attraction for tourists. However, information is not yet available that can 

help tourists in knowing the objects and tourist areas contained in Tegal 

Island. This research presents tourism information in Tegal Island in the 

form of a Geographic Information System map. The mapping method is 

done using Quantum GIS software with the help of the QuickMapServices 

(QMS) plugin to display Google Earth imagery and the qgis2web plugin 

to convert QGIS files (.qgz) into web maps (WebGIS) and the presence of 

tourist index input. The mapping results obtained digitization of each 

tourist object and facility on Tegal Island in the form of shapefiles (.shp) 

as well as information displayed on the attribute table layer. WebGIS is 

used as a media for GIS map renderers that is easily accessed and 

adjusted according to the JavaScript Leaflet library (open source). Map of 

Geographic Information Systems makes it easy for people to convey and 

search for tourist information on Tegal Island. 
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Introduction 

Indonesia is an archipelagic country that 

has the potential to utilize coastal areas as a 

marine ecotourism area (Koroy, Kismanto, 

Fredinan Yulianda, 2017). Indonesia has large and 

small islands that number ± 17,504 islands and 

occupies the second-longest coastline after 

Canada, which is 95,161 km (Lasabuda, n.d.) so 

that Indonesia has several areas that can utilize as 

marine ecotourism areas along the existing 

coastline area. 

One of the marine ecotourism areas 

located in Lampung Province is Tegal Island. 

Tegal Island located in Gebang Village, Padang 

Cermin District, Pesawaran Regency, Lampung 

Province. Tourists use a motorboat with a travel 

time of ± 15 minutes from Sari Ruding Beach to 

access the island (Titaheluw, Syahnul Sardi, 2012). 

The island was covering an area of ± 140 Ha 

inhabited by around 20 family heads(Anggraini, 

Desti Rizki, Abdullah Aman Damai, 2018). Tegal 
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Island is an area suitable to be developed into 

ecotourism. 

Ecotourism defined as any form of nature-

based tourism, where tourists can observe and 

appreciate nature and the traditional culture 

contained in it (World Tourism Organization, 

2018). Ecotourism must contain elements of 

education, interpretation of natural areas, and 

aims to minimize the negative impacts on nature 

and the socio-cultural nature of tourism 

activities(Ruhanen, 2019). Ecotourism 

development is expected to support the 

maintenance of natural areas, generate economic 

benefits for the manager, provide alternative 

employment, and increase awareness of nature 

for local people and tourists. 

Ecotourism activities must apply the 

following principles: 1. Reduce the physical 

environmental and cultural impacts of the 

community; 2. Develop awareness and 

appreciation of the environment and culture of 

the community; 3. Provide a positive experience 

for visitors and managers; 4. Generate financial 

benefits for conservation; 5. Generate economic 

profits for the local community and managers; 6. 

Offering a memorable interpretive experience for 

visitors; 7. Design, build, and operate low-impact 

facilities; 8. Accept the customs and spiritual 

beliefs of the local population and work together 

to make empowerment (The International 

Ecotourism Society 2015).  

This principle is in line with the concept of 

sustainable ecotourism development (Haryanto, 

2016) so that the ecotourism area managed as a 

source of sustainable community income, as well 

as an effort to preserve the culture of the 

community and the potential of local natural 

resources. 

One of the natural ecotourism that has a 

diversity of tourist objects and activities is marine 

ecotourism (Abdillah, 2016). Marine ecotourism is 

a tourist attraction and purpose that comes from 

the potential seascape and coastal landscape. 

Tourism originating from seascape potential is 

tourism activities that prioritize the wealth of 

marine resources and seawater dynamics, while 

coastal landscape tourism is tourism activities 

that based on resources in coastal areas and the 

culture of surrounding communities (Yulianda, 

2007). Events that often offered in marine ecotou 

rism are beach recreation, outdoor activities, and 

biota observations that interact in coastal 

ecosystems. 

One of the weaknesses in the development 

of ecotourism areas is the lack of information 

about existing tourist attractions, and this makes 

it difficult for tourists to obtain information that 

indirectly impacts the number of visitors. The 

provision of ecotourism information often 

ignored, especially areas that are still managed by 

the local community. Information on tourist 

objects generally obtained orally or through 

other media that are less informative 

(Soyusiawaty, Dewi, Rusydi Umar, 2007). 

The development of ecotourism areas is 

inseparable from the promotion of attractions 

related to increasing tourist attraction. 

Advertising is carried out to provide an overview 

and information about an object or tourist area. 

This information is used by tourists to adjust 

tourism needs with tourist destinations 

(Rahmayanti, Yunita Dwi, 2013). 

Problems regarding the need for information 

related to attractions on Tegal Island cause the 

need for a media about that information. The 

purpose of this study is to present tourist 

information on Tegal Island in the form of a 

Geographic Information System map. Maps are a 

natural means of indexing and presenting 

tourism related information (Jovanović & Njeguš, 

2008). The information presented is related to the 

tourism suitability index (IKW) and regional 

carrying capacity (DDK). The benefits of this 

research are providing information related to the 

marine ecotourism area on Tegal Island in the 

form of a website that can be accessed by the 

wider community easily. 
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Methode 

1. Research sites 

The research location located in Tegal Island, 

Gebang Village, Padang Cermin District, 

Pesawaran Regency, Lampung Province. 

Geographically the island is located at 

coordinates 05 ° 34 '00 "LS and 105 ° 16 '29" BT 

(Oriana, Nindita, Isni Nurruhwati, Indah Riyantini, 

2017). 

 

Figure 1. Map of Aerial Photos of Tegal Island

2. Equipment 

The equipment used to retrieve data in this 

study showed in Table 1. 

 

Table 1. Peralatan Penelitian 

No Peralatan Fungsi 

1 GPS (Global Positioning 

System) 

Carrying out coordinates of a point (waypoint) or route (track) of a 

particular research object. 

2 Camera Take documentation of research data, in the form of images or 

videos. 

3 Laptop Compile data that has been obtained and processed using the 

Quantum GIS program. 

4 Drone Aircraft Obtain documentation of a research object from a certain height. 

5 Roll meter Measuring length and height. 

6 Secchi disk Measures the level of water brightness. 

7 50 × 50 cm squares Calculate the seagrass cover using the quadratic transect method. 

8 Bottle Buoy and 

Stopwatch 

Calculate the current speed. 

9 Wooden Sticks and 

Water Pass Hose 

Measure the beach slope. 

10 Wooden Peg Gives a tidal boundary mark. 

11 Snorkel Glasses Help observations made underwater. 

 

 

 

 



 

3. Potential Attractions 

Analysis of the potential of attractions is 

needed to determine the suitability of a tourist 

area as a whole. Parameters arranged based on 

their importance in the conformity matrix, while 

the weighting of each parameter obtained from 

the scoring method. The settings used to refer 

to(Pusat Studi Pariwisata Universitas Gadjah 

Mada (PUSPAR UGM), 2005), while the equation 

in counting refers to (Yulianda, 2007). The 

categories of potential tourism object classes 

showed in Table 2. 

Table 2. Potential Attraction Class Category 

No. Score Information 

1 ≥77 - 100% Suitable 

2 ≥55 - 76% Quite Suitable 

3 <55% Not Suitable 

 

4. Travel Conformance Index 

In a tourist area, there is more than one 

tourist attraction. Each suitability level can be 

calculated based on the suitability matrix 

(Yulianda, 2007) so that the development of 

attractions adjusted to the potential of resources 

and allocation. The final result is the number of 

multiplications between the weights and scores 

of each parameter, which is then divided by the 

maximum score. Suitability of objects and tourist 

areas seen from the suitability percentage 

obtained through the equation (Yulianda, 2007). 

The Tourism Conformity Index (IKW) uses a 

suitability matrix arranged based on the level of 

importance of each parameter (Domo, Attur 

Mudzy, Zulkarnaini, 2017). The equation used in 

calculating tourism suitability refers to Yulianda 

(2007), namely: 

IKW = ∑(
Ni

Nmaks

)× 100% 

Information: 

IKW: Tourism Suitability Index 

Ni: Value of the i parameter (score × weight) 

Nmax: The maximum value of all compliance 

parameters 

The results obtained through the conformity 

matrix categorized in 4 categories, namely: 

S1: Very suitable (75-100%) 

S2: Appropriate (50-74%) 

S3: Conditionally conditional (25-49%) 

N: Not proper (<25%) 

1) IKW Beach Recreation Category 

 The tourism suitability matrix for the beach 

recreation category has ten parameters in it with 

a Nmax value of all 84 parameters. Quantitative 

data measurements carried out three times. The 

depth of the beach measured at a distance of 10 

m from the coastline (Yulisa, Eka Noerma, Yar 

Johan, 2016). Beach width measured from the last 

vegetation boundary up to the shoreline. The 

type of beach, seabed material, coastal land 

cover, and hazardous biota obtained through 

direct observation at the research station 

(Ramadhan, Syahru, Pindi Patana, 2014). The 

tourism suitability matrix for the beach recreation 

category shown in Table 3. 

Table 3. IKW Matrix in the Coastal Recreation Category 

No Parameters 

W
e
ig

h
t 

Category 

S1 S
c
o

re
 

Category 

S2 S
c
o

re
 

Category 

S3 S
c
o

re
 

Category 

N S
c
o

re
 

1 The Dept of 

the Beach 

(m) 

5 0-3 3 >3-6 2 >6-10 1 >10 0 

2 Beach Type 5 white 

sand 

3 white 

sand, a 

pinch of 

clam 

2 Black sand, 

craggy, 

little steep 

1 dirth, stony, 

steep 

0 
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No Parameters 

W
e
ig

h
t 

Category 

S1 S
c
o

re
 

Category 

S2 S
c
o

re
 

Category 

S3 S
c
o

re
 

Category 

N S
c
o

re
 

3 Wide Beach 

(m) 

5 >15 3 10-15 2 3-<10 1 <3 0 

4 Aquatics 

Material 

3 Sand 3 Sandy 

Reefs 

2 Sand 

Muddy 

1 Mud 0 

5 Current 

Speed (m/s) 

3 0-0.17 3 0.17-0.34 2 0.34-0.51 1 >0.51 0 

6 Beach Tilt 

(o) 

3 <10 3 10-25 2 >25-45 1 >45 0 

7 The 

Brightness 

of the 

waters (%) 

1 100 3 50-<100 2 30-<50 1 <30 0 

8 Coastal 

landclosing 

1 coconut, 

bare 

ground 

3 bush, 

shrub, 

lowliness, 

savana 

2 high shrub 1 mangrove, 

settlement, 

port 

0 

9 Dangerous 

Biotic 

1 none 3 Sea-

urchin 

2 sea-surchin, 

ray  

1 sea-urchin, 

ray, lepu, 

shark 

0 

10  Availabilty 

of fresh 

water (km) 

1 <0.5 3 >0.5-1 2 >1-2 1 >2 0 

Source: Yulianda, 2007

2) IKW Mangrove Tourism Category  

The tourism suitability matrix for the 

mangrove tourism category has five parameters 

in it with a Nmax value of all 39 parameters. The 

thickness of the mangrove measured from the 

outline of the mangrove (towards the land) to the 

coastline. Mangrove density is calculated based 

on the number of mangrove individuals in an 

area of 100 m2 (Dharmawan, I Wayan Eka, 2014). 

Mangrove species and biota objects obtained 

through direct observation of mangrove areas. 

The tourism suitability matrix for the mangrove 

tourism category shown in Table 4. 

Table 4. IKW Matrix Mangrove Tour Category 

No Parameter 

W
e
ig

h
t 

Category 

S1 S
c
o

re
 

Category 

S2 S
c
o

re
 

Category 

s3 S
c
o

re
 

Category 

N S
c
o

re
 

1 Mangrove 

Thickness 

(m) 

5 >500 3 >200-500 2 50-200 1 <50 0 

2 Mangrove 

Density 

(100 m2) 

3 >15-20 3 >10-15, 

>20 

2 5-10 1 <5 0 



 

3 Mangrove 

Types 

3 >5 3 3-5 2 1-2 1 0 0 

4 Low Tides 

(m) 

1 0-1 3 >1-2 2 >2-5 1 >5 0 

5 Biotic 

Object 

1 fish, shrimp, 

crab, mollusc, 

reptile, bird. 

3 fish, 

shrimp, 

crab, 

mollusc, 

2 fish, 

mollusc 

1 ne of the 

water 

biotic 

0 

Source: Yulianda, 2007

 

3) IKW Seagrass Tourism Category 

The tourism suitability matrix for the 

seagrass tourism category has seven parameters 

in it with a Nmax value of all parameters of 51. 

Seagrass cover is calculated using the quadratic 

transect method perpendicular to the 

coastline(Rahmawati, Susi, Andri Irawan, Indarto 

Happy Supriyadi, 2014). The depth of the 

seagrass measured at the starting point of 

seagrass vegetation found from the shoreline. 

Seagrass species and substrate types were 

obtained by direct observation at the study site. 

Fish species at the study site obtained from the 

Department of Fisheries and Maritime Affairs of 

Lampung Province. The tourism suitability matrix 

for seagrass tourism categories shown in Table 5. 

Table 5. IKW Matrix Seagrass Tourism Category 

No 
Parameter

s 

W
e
ig

h
t 

Category 

S1 S
c
o

re
 

Category 

S2 S
c
o

re
 

Category 

S3 S
c
o

re
 

Category 

N S
c
o

re
 

1 Segrass 

Cover (%) 

5 >75 3 >50-75 2 25-50 1 <25 0 

2 Wter 

Brightness 

(%) 

3 >75 3 >50-75 2 25-50 1 <25 0 

3 Fish Types 3 >10 3 6-10 2 3-5 1 <3 0 

4 Seagrass 

Types 

3 Cymodoce

a 

Halodule 

Halophila 

3 Syringodium 

Thalassodendro

n 

2 Thallasia 1 Enhalus 0 

5 Substrate 

Types 

1 Pasir 

berkarang 

3 Pasir 2 Pasir 

berlumpu

r 

1 Berlumpu

r 

0 

6 Current 

Speed 

(cm/s) 

1 0-15 3 15-30 2 30-50 1 >50 0 

7 The Deepth 

of Seagrass 

(m) 

1 1-3 3 >3-6 2 >6-10 1 >10, <1 0 

Source: Yulianda, 2007
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4) IKW Diving Tourism Category 

The diving tourism suitability matrix has six 

parameters with a Nmax value of 54. Coral 

community cover is calculated using the LIT (Line 

Intercept Transect) method with a transect line 

along 50 m parallel to the coastline (Giyanto, 

Manuputty Anna EW, Abrar Muhammad, 

Siringoringo Rikoh M, Suharti Sasanti R, Wibowo 

Kunto, Edrus Isa Nagib, 2014). The depth of the 

coral reef measured at the starting point of 

finding coral communities from the shoreline. 

Lifeform types were obtained from local 

developers, while reef fish species collected from 

the Lampung Province Office of Maritime Affairs 

and Fisheries. The tourism suitability matrix for 

the diving category shown in Table 6. 

Table 6. IKW Matrix of Diving Tourism 

No Parameters 

W
e
ig

h
t 

Category 

S1 S
c
o

re
 

Category 

S2 S
c
o

re
 

Category 

S3 S
c
o

re
 

Category 

N S
c
o

re
 

1 Water Brigthness 

(%) 

5 >80 3 50-80 2 20-<50 1 <20 0 

2 Coral Community 

Cover (%) 

5 >75 3 >50-75 2 25-50 1 <25 0 

3 Lifeform Types 3 >12 3 <7-12 2 4-7 1 <4 0 

4 Reef Fish Types 3 >100 3 50-100 2 20-<50 1 <20 0 

5 Current Speed 

(cm/s) 

1 0-15 3 >15-30 2 >30-50 1 >50 0 

6 The Depth of The 

Coral Reef (m) 

1 6-15 3 >15-20 

3-<6 

2 >20-30 1 >30 

<3 

0 

Source: Yulianda, 2007 

5) IKW Snorkeling Tourism Category  

The snorkel tourism suitability matrix has 

seven parameters with a Nmax value of 57. The 

width of the reef stretch is the distance 

perpendicular to the coastline, starting from the 

point where coral reefs found to the point where 

coral reefs found. The suitability matrix of the 

snorkeling tourism category shown in Table 7. 

Table 7. Matriks IKW Kategori Wisata Snorkeling 

No Parameter 

B
o

b
o

t 

Kategori 

S1 S
k

o
r Kategori 

S2 S
k

o
r Kategori 

S3 S
k

o
r Kategori 

N S
k

o
r 

1 Kecerahan perairan (%) 5 >80 3 50-80 2 20-<50 1 <20 0 

2 Tutupan komunitas 

karang (%) 

5 >75 3 >50-75 2 25-50 1 <25 0 

3 Jenis lifeform 3 >12 3 <7-12 2 4-7 1 <4 0 

4 Jenis ikan karang 3 >50 3 30-50 2 10-<30 1 <10 0 

5 Kecepatan arus (cm/s) 1 0-15 3 >15-30 2 >30-50 1 >50 0 

6 Kedalaman terumbu 

karang (m) 

1 1-3 3 >3-6 2 >6-10 1 >10; <1 0 

7 Lebar hamparan datar 

karang (m) 

1 >500 3 >100-

500 

2 20-100 1 <20 0 

Source: Yulianda, 2007



 

6) Regional Carrying Capacity 

The calculation of the carrying capacity of 

the area, is used to determine the maximum size 

of tourists who can accommodate at any given 

time without disrupting nature or humans 

(Domo, Zulkarnaini, and Yoswaty 2017). In this 

study, the equation of the carrying capacity of a 

tourist area refers to (Yulianda, 2007), namely: 

DDK = K × 
Lp

Lt
 × 

Wt

Wp
 

Information: 

DDK: Regional carrying capacity 

K: Ecological potential of visitors 

LP: Area or length of the area used 

Lt: Area of unit area for a tourism activity 

Wt: Time provided by the area per day 

Wp: Time needed by visitors in tourism activities 

Result and Discusion 

Tegal Island has an ecotourism attraction 

with its natural wealth. This island divided into 

four regions, namely north, east, south, and west. 

The northern part is the main focus of developers 

in the provision of facilities and attractions. The 

development of facilities and tourist attractions 

on this island continues to do to provide a 

magnet for tourists. 

1. Calculation of Potential Attractions 

The data collected is then adjusted to the 

matrix of potential tourist attractions. Data 

obtained through observation, analysis, and 

relevant agencies. After that, the score of each 

parameter is summed and calculated using the 

equation (Yulianda, 2007), so that the suitability 

category of potential tourism objects obtained on 

Tegal Island. Table 8 shows that the total score 

received was 35 out of 39 total scores. The 

suitability category of marine ecotourism areas is 

obtained at 89.74% and falls into the Appropriate 

(S2) category. 

Table 8.  Potential Objects of Tourist Attraction 

No. 

Potential 

Assessment 

Factors 

Variable Criteria Score Result 

1 Quality of 

Tourism Object 

a. Keunikan objek 

wisata dan fungsi 

sebagai kawasan 

lindung The Uniqueness 

of tourism object and 

functions as protected 

area 

• If the object found elsewhere 

• If the object found elsewhere 

and have protective function 

• If the object rarely found 

elsewhere and have protective 

function 

1 

 

2 

 

3 

 

 

 

 

✔ 

b. Diversity of 

supporting attractions 

• Don't have attractions yet 

• Has 1-2 supporting attractions 

• Has> 2 supporting attractions 

1 

2 

3 

 

 

✔ 

2 Attraction 

condition 

c. The cleanliness of the 

tourism object and the 

availability of land for 

development 

• The tourism object is less clean 

and has no land for 

development 

• Attractions are decent but do 

not have area for development, 

or vice versa 

• Tourism objects are clean and 

have development land 

1 

 

2 

 

 

3 

 

 

 

 

 

✔ 

3 The economic 

competitiveness 

d. The number of 

tourists 

• Number of tourists is low 

• Moderate tourist numbers 

1 

2 

 

 



Herison A, et al | Vol 19 No 2 Tahun 2019  

 

SPATIAL Journal of Geographical Studies |35  

 

No. 

Potential 

Assessment 

Factors 

Variable Criteria Score Result 

of tourism 

objects 

• High tourist numbers 3 ✔ 

e. Ticket prices • Ticket prices are expensive 

• Ticket prices are moderate 

• Cheap ticket prices 

1 

2 

3 

 

✔ 

4 Accessibility f. Road infrastructure to 

the location of 

attractions 

• Available motor and car road 

infrastructure 

• Available road infrastructure 

that can be passed by 

motorbikes and cars, there are 

alternative roads that can 

develop, in poor condition 

• Available motorbike and car 

road infrastructure, there are 

alternative roads that can be 

designed, in good condition 

1 

 

2 

 

 

 

3 

✔ 

g. Travel time for 

tourists to a tourist 

attraction from the 

capital 

• Travel time> 2 hours from the 

capital 

• Travel time is 1-2 hours from 

the capital 

• Travel time <2 hours from the 

capital city 

1 

2 

3 

 

 

✔ 

h. Availability of public 

transportation to get to 

the location of 

attractions 

• Public transit is not available 

• Public transport is possible, not 

regular 

• Public transportation is 

available, regular 

1 

2 

3 

 

 

✔ 

5 Support the 

development of 

attractions 

i. Object development 

support 

• No manager 

• Only managed 

• Tourism objects are regulated 

by the government and the 

community / private sector 

professionally 

1 

2 

3 

 

 

✔ 

  j. Development and 

promotion of tourism 

object 

• Tourism objects have not yet 

been developed or published 

• Tourism objects have been 

designed but not yet published 

• Tourism objects developed and 

published 

1 

 

2 

 

3 

 

 

 

 

✔ 

6 Supporting 

tourist 

attraction 

facilities 

k. Availability of 

facilities to meet 

residents’ physical and 

social needs 

• Not available 

• 1-2 types of simple facilities are 

available 

• Available> 2 types of private 

1 

2 

3 

 

 

✔ 



 

No. 

Potential 

Assessment 

Factors 

Variable Criteria Score Result 

facilities 

7 Complimentary 

facilities 

l. Availability of 

complementary facilities 

(parking lots, toilets / 

WC, information centre) 

• Tidak tersedia 

• Not available 

• 1-2 types of facilities are 

available 

• Available> 2 types of facilities 

m. 

1 

2 

3 

 

 

✔ 

8 Safety and 

comfort 

m. Security of the area 

around the tourist 

attraction 

• Crimes often occur around the 

area of the tourist attraction 

• Rarely occurs crime around the 

tourist area attraction 

• There has never been a crime 

in the area around the tourist 

attraction 

1 

 

2 

 

3 

 

 

✔ 

Total Score (Ni) 35 

Score Maxsimum (Nmaks) 39 

Persentage ((Ni/Nmaks)×100%) 89.74% 

Category of Tourism Object Potency Class  Suitable 

Source: PUSPAR UGM, 2005 

2. IKW Calculation of the Beach 

Recreation Category  

Tegal Island has a coastline around the 

island. The primary beach material in the form of 

white sand and open land cover with coconut 

trees add to the natural beauty on Tegal Island. 

The condition of a gentle slope of the beach 

makes the beach area on Tegal Island safe as a 

recreational object.  

Table 9. Travel Conformance Index Beach Recreation Category 

No Parameters Weight 

Category 

S1 

Score (3) 

Category 

S2 

Score (2) 

Category 

S3 

Score (1) 

Category 

N 

Score (0) 

1 Beach depth (m) 5 0-3 - - - 

2 Beach type 5 White Sand - - - 

3 Beach Width (m) 5 - - 3-<10 - 

4 Underwater material 3 Sand - - - 

5  

Current Speed (m / s) 

3 - 0.17-0.34 - - 

6 Beach slope (o) 3 <10 - - - 

7 Waters Brightness (%) 1 100 - - - 

8 Coastal land cover 1 Coconut, Bare 

Ground 

- - - 

9 Biota is dangerous 1 None - - - 

10 Availability of freshwater 1 <0.5 - - - 
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No Parameters Weight 

Category 

S1 

Score (3) 

Category 

S2 

Score (2) 

Category 

S3 

Score (1) 

Category 

N 

Score (0) 

(km) 

Amount 28 60 6 5 0 

Ntotal 71 

Nmaks 84 

IKW ((Ntotal/Nmaks)×100%) 84.52% 

Category Very Suitable (S1) 

 

Table 9 shows that the total value obtained 

was 71 from the maximum amount of 84. The 

percentage of the tourism suitability index for the 

beach recreation category on Tegal Island was 

84.52% and included in the very appropriate 

category (S1).  

3. IKW Calculation for Mangrove Tourism 

Category  

Based on direct observations, the number of 

mangrove individuals found on Tegal Island is 

relatively small. The lack of individual mangroves 

influenced by several things, such as the 

condition of the substrate on Tegal Island in the 

form of white sand and a little mud deposit. 

In contrast, mangroves generally live in 

muddy areas. There are three mangrove forests, 

each in the east and west. Types of mangroves 

found at the study site were Avicennia and 

Rhizophora. Rhizophora dominates mangrove 

species on Tegal Island.  

Table 10. Travel Conformance Index Mangrove Tourism Category 

No Parameters Weight 

Category 

S1 

Score (3) 

Category 

S2 

Score (2) 

Category 

S3 

Score (1) 

Category 

N 

Score (0) 

1 Mangrove thickness (m) 5 - - - <50 

2 
Mangrove density (100 

m2) 

3 - - - <5 

3 Mangrove type 3 - - 1-2 - 

4 Tidal (m) 1 0-1 - - - 

5 
Biotic Object 1 Fish, Shrimp, Crab, 

mollusc, reptile, bird. 

- - - 

Amount 13 6 0 3 0 

Ntotal 9 

Nmaks 39 

IKW ((Ntotal/Nmaks)×100%) 23.08% 

Category Not Suitable (N) 

 

Table 10 shows that the total value obtained 

was 9 out of a maximum amount of 39. The 

percentage of the tourism suitability index for the 

beach recreation category on Tegal Island was 

23.08% and included in the inappropriate 

category (N). 

 

4. IKW Calculation for Seagrass Tourism 

Category  

Seagrasses grow and live around Tegal 

Island. Seagrass is a plant that lives at the bottom 

of the water and needs sunlight for 

photosynthesis. The level of water brightness 

influences the amount of sun that can reach the 

bottom of the water. The type of sand substrate 



 

on Tegal Island is very suitable for seagrass 

habitat because it does not affect the level of 

water brightness. The kinds of seagrass found on 

Tegal Island, namely Enhalus, Halodule, and 

Thalassia. Halodule is a type of seagrass that 

dominates on Tegal Island. Many aquatic biotas 

live in seagrass beds, such as small fish, mollusks, 

and crustaceans.  

Table 11. Travel Conformance Index Seagrass Tourism Category 

No Parameters Weight 

Category 

S1 

Score (3) 

Category 

S2 

Score (2) 

Category 

S3 

Score (1) 

Category 

N 

Score (0) 

1 Seagrass cover (%) 5 - >50-75 - - 

2 Waters Brightness 

(%) 

3 >75 - - - 

3 Fish species 3 >10 - - - 

4 Seagrass type 3 Enhalus, Halodule, 

Thalassia 

- - - 

5 Substrate type 1 - Pasir - - 

6 Current Speed (cm / 

s) 

1 - 15-30 - - 

7 Seagrass depth (m) 1 1-3 - - - 

Jumlah 17 30 14 0 0 

Ntotal 44 

Nmaks 51 

IKW ((Ntotal/Nmaks)×100%) 86.27% 

Category Very Suitable (S1) 

 

Table 11 shows that the total value was 44 

from the maximum amount of 51. The 

percentage of the tourism suitability index for the 

seagrass category in Tegal Island was 86.27% and 

included in the very appropriate category (S1).  

5. IKW Calculation for Diving Tourism 

Category  

Tegal Island can attract tourists to observe 

the beauty of the vast expanse of coral reefs and 

the diversity of reef fish species. Coral reefs found 

at a depth of ± 3 m around Tegal Island. Based 

on Tegal Mas Island Developer data, there are 12 

types of life forms of living coral on Tegal Island. 

Coral reef ecosystems have many unusual aquatic 

biotas to be observed, such as reef fish, starfish, 

and anemones, which are home to several types 

of small fish. Some endangered biota also found 

around coral reefs, such as sea urchins, sea 

cucumbers, and jellyfish. 

Table 12. Suitability Index of the Dive Tourism Category 

No Parameters Weight 

Category 

S1 

Score (3) 

Category 

S2 

Score (2) 

Category 

S3 

Score (1) 

Category 

N 

Score (0) 

1 Waters Brightness (%) 5 >80 - - - 

2 Coral community cover (%) 5 >75 - - - 

3 Type of life form 3 - <7-12 - - 

4 Types of reef fish 3 - - 20-<50 - 

5 Kecepatan arus (cm/s) 1 - >15-30 - - 

6 Coral reef depth (m) 1 - 3-<6 - - 
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Jumlah 18 30 10 3 0 

Ntotal 43 

Nmaks 54 

IKW ((Ntotal/Nmaks)×100%) 79.63% 

Category Very Suitable (S1) 

 

Table 12 shows that the total value 

obtained was 43 out of a maximum amount of 

54. The percentage of the tourism suitability 

index for the beach recreation category on Tegal 

Island was 79.63% and included in the very 

appropriate category (S1).  

6. IKW Calculation for Snorkeling 

Tourism Category  

Snorkeling has done in the same area as 

diving tourism, which is on a stretch of coral reef. 

This tour is conducted to observe the beauty of 

coral reefs and aquatic biota contained in it. 

Snorkeling has done on the surface of the water, 

so tourists do not need to have special abilities in 

terms of diving.  

Seven parameters can determine the 

suitability index of snorkeling tourism on Tegal 

Island. The settings available are similar to the 

IKW matrix in the diving tourism category. Still, 

there are additional parameters that focus on the 

width of a flat reef as a snorkeling tour. 

Table 13. Travel Conformance Index Snorkeling Tourism Category 

No Parameters Weight 

Category 

S1 

Score (3) 

Category 

S2 

Score (2) 

Category 

S3 

Score (1) 

Category 

N 

Score (0) 

1 Waters Brightness (%) 5 >80 - - - 

2 Coral community cover (%) 5 >75    

3 Type of life form 3 - <7-12 - - 

4 Types of reef fish 3 - 30-50 - - 

5 Current Speed (cm / s) 1 - >15-30 - - 

6 Coral reef depth (m) 1 - >3-6 - - 

7 Flat reef stretch (m) 1 - >100-500 - - 

Amount 19 30 18 0 0 

Ntotal 48 

Nmaks 57 

IKW ((Ntotal/Nmaks)×100%) 84.1% 

Category Very Suitable (S1) 

 

Table 13 shows that the total value 

obtained was 48 out of the maximum amount of 

57. The percentage of the tourism suitability 

index for the beach recreation category on Tegal 

Island was 84.21% and included in the very 

appropriate category (S1).  

7. Calculation of Regional Carrying 

Capacity 

The calculation of the carrying capacity of 

the area is carried out to determine the maximum 

size of visitors that can accommodate at a 

particular time without causing disturbance to 

nature or humans. The carrying capacity of the 

area for beach recreation, mangrove tourism, 

seagrass tourism, diving, and snorkeling obtained 

through the calculation of the carrying capacity 

of the region.  

 

 

 



 

Table 14. Calculation of Carrying Capacity of Tourism Object Areas 

No Objek Wisata K Lp Lt Wt Wp DDK 

1 Beach recreation 1 795.77 m 50 m 6 3 31 

2 Mangrove tourism 1 110.17 m 50 m 8 2 8 

3 Seagrass tourism 1 3884.87 m2 250 m2 4 2 31 

4 Dive 2 5327.9 m2 2000 m2 8 2 21 

5 Snorkeling 1 5327.9 m2 500 m2 6 3 21 

Total DDK (person/day) 112 

 

Table 14 shows that the carrying capacity 

of the area was 31 visitors/day for beach 

recreation, eight people/day for mangrove 

tourism, 31 people/day for seagrass tours, 21 

people/day for diving tours, and 21 people/day 

for snorkeling. 

8. Mapping Based on Geographic 

Information Systems  

After collecting and analyzing data related 

to marine ecotourism objects and areas on Tegal 

Island. GIS can be used in tourism as a decision 

supporting tool for sustainable tourism planning, 

impact assessment, visitor flow management, and 

tourism site selection (Rahman, 2010). 

Furthermore, the data will inform in a digital map 

through Quantum GIS software. Quantum GIS is 

software used to create digital maps of regions 

and display information in the form of text and 

images. Tourists can access a map of the area, 

find out tourist information, and see an overview 

of the region through a GIS map. Mapping using 

GIS-based software is quite efficient and 

straightforward in the data input process. The 

steps taken in mapping using Quantum GIS 

software are as follows:  

1) They are digitizing the area that will use as a 

map object. Digitization can be in the form 

of territorial boundaries, access roads, and 

streams. If scanning is not possible, a map of 

the area's shapefiles can use. The plan of 

regional shapefiles that commonly used is a 

map of the province. 

2) Creating a new layer of a particular object 

following existing data points or 

coordinates. The steps taken are to click 

Layer → Create Layer → New Shapefile Layer 

or press on the keyboard Ctrl + Shift + N. 

3) In the New, Shapefile Layer menu, select the 

options that are tailored to the needs of the 

layer to be created, namely: 1. Select 

polygon type for the sheet in the form of the 

polygon; 2. EPSG map format: 32748-WGS 

84 / UTM Zone 48S; and 3. Fields adjusted 

according to layer requirements. 

4) Each layer can display information related to 

the results of digitizing an area. The 

attributes in the form of tourist information 

posted by right-clicking on the layer used 

open Attribute Tables and New Field and fill 

in the characteristics following of knowledge 

has obtained, such as location coordinates, 

availability of facilities, and infrastructure, as 

well as the results of regional 

documentation. 

5) Digitize each object by clicking Toggle 

Editing → Add Feature. Digitizing the object 

is adjusted to the location and coordinates 

obtained from the GPS. 

6) Input information on the Attribute Table 

from the results of data analysis that has 

achieved. 

7) Adjust the appearance of each digitization of 

tourist attractions by right-clicking Layer → 

Properties → Style → Color. The thickness of 
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the lines, shading, and transparency of the 

layer adjusted through the menu. 

8) Repeating step 2 to step 7 until all 

attractions have digitized, the information 

inputted, and the appearance changed to 

the entire digital map. 

In the development of geographic 

information system technology, digital GIS maps 

are not only accessed through Quantum GIS 

software but can also access via the website. The 

website has chosen as media accessed through 

electronic devices connected to the internet. 

Some plugins needed in building WebGIS 

maps and these plugins are available in the 

Quantum GIS software plugin directory. The 

steps taken are: click on the Plugins Tab → 

Manage and install plugins → search for plugins 

→ Install plugins. The QuickMapServices (QMS) 

plugin is used to display Google Earth imagery, 

so digital maps with aerial visuals obtained. The 

qgis2web plugin is used to process a QGIS (.qgs) 

file consisting of several shapefile (.shp) data into 

a website database file (.html). The steps taken 

are:  

1) Press the Create web map icon on the Plugin 

Toolbar. 

2) After the "Export to web map" window 

opens, then make adjustments to the Layers 

and Groups menu. 

3) Change the entire label layer that will display 

information into inline labels (subject and 

information in one line) or header labels 

(issue and knowledge in different lines) that 

tailored to the needs of information display. 

4) Select JavaScript Leaflet on the menu 

available at the bottom. 

5) Export the QGIS file by clicking the "Export" 

menu. 

6) When finished, the digital map will 

automatically open in the browser software 

used. Re-check the completeness of the 

layer and the information displayed. 

The converted Quantum GIS file uploaded 

into the hosting website that prepared. Choose a 

domain name that matches the designed GIS 

map. The use of a memorable domain name can 

make it easier for users to access websites, such 

as place names or mapping areas. The steps 

taken are: 

1) It is setting up a domain and website 

hosting. This study uses a domain provider 

and website hosting site 

https://id.000webhost.com/. 

2) Register for a new account and follow the 

steps given to determine the domain name 

for the new website. The domain name used 

must be available and developing the 

contents of WebGIS. 

3) After the domain name is approved, the 

website settings will then appear. To upload 

a website database file, the steps taken are: 

a. Select menu: Tools → File manager → 

Upload File. b. The page automatically 

redirects to web hosting. The next step is: 

select menu public_html → Upload Files → 

Select Files (website data in .zip format) 

Upload. c. Extract files that have uploaded 

into the public_html folder. WebGIS file 

successfully saved into web hosting. 

4) Re-checking WebGIS (complete layers and 

information from each layer). The website of 

the geographic information system map of 

the marine ecotourism area of Tegal Island 

accessed via the URL 

https://tegalmas.000webhostapp.com/. 

https://id.000webhost.com/
https://tegalmas.000webhostapp.com/


 

 

Figure 2. Display of GIS Map on Website 

 

 

Conclusion 

The conclusion is that the mapping of tourist 

objects and areas in Tegal Island was successfully 

carried out using Quantum GIS software, which 

accessed through the website. GIS Mapping helps 

the community in finding and knowing tourist 

information on Tegal Island. 

Reference 

Abdillah, D. (2016). Pengembangan Wisata Bahari 

Di Pesisir Pantai Teluk Lampung. Jurnal 

Destinasi Kepariwisataan Indonesia 1, 1, 45–

65. 

Anggraini, Desti Rizki, Abdullah Aman Damai,  

and Q. H. (2018). Analisis Kesesuaian 

Perairan Untuk Budidaya Ikan Kerapu Bebek 

(Cromileptes Altivelis) Di Perairan Pulau 

Tegal Teluk Lampung. E-Jurnal Rekayasa 

Dan Teknologi Budidaya Perairan 6, 2, 719–

28. Retrieved from 

https://doi.org/10.23960/jrtbp.v6i2.p719-

728 

Dharmawan, I Wayan Eka,  and P. (2014). 

Panduan Monitoring Status Ekosistem 

Mangrove (Pramudji and Anugerah Nontji, 

ed.). Jakarta: PT. Sarana Komunikasi Utama. 

Domo, Attur Mudzy, Zulkarnaini,  and D. Y. 

(2017). Analisis Kesesuaian Dan Daya 

Dukung Kawasan Wisata Pantai (Studi 

Pantai Indah Sergang Laut Di Pulau 

Singkep). Dinamika Lingkungan Indonesia 4, 

2, 109–16. 

Giyanto, Manuputty Anna EW, Abrar Muhammad, 

Siringoringo Rikoh M, Suharti Sasanti R, 

Wibowo Kunto, Edrus Isa Nagib,  et al. 

(2014). Panduan Monitoring Kesehatan 

Terumbu Karang. Edited by Suharsono and 

Ono Kurnaen Sumadhiharga. Jakarta: PT. 

Sarana Komunikasi Utama. 

Haryanto, J. T. (2016). Model Pengembangan 

Ekowisata Dalam Mendukung Kemandirian 

Ekonomi Daerah Studi Kasus Provinsi Diy. 

Jurnal Kawistara 4, 3, 225–330. Retrieved 

from 

https://doi.org/10.22146/kawistara.6383 

Jovanović, V., & Njeguš, A. (2008). The application 

of gis and its components in tourism. 

Yugoslav Journal of Operations Research, 

18(2), 261–272. 

https://doi.org/10.2298/YJOR0802261J 

Koroy, Kismanto, Fredinan Yulianda,  and N. A. B. 

(2017). Pengembangan Ekowisata Bahari 

Berbasis Sumberdaya Pulau- Pulau Kecil Di 

Pulau Sayafi Dan Liwo, Kabupaten 

Halmahera Tengah. Jurnal Teknologi 

Perikanan Dan Kelautan 8, 1, 1–17. 

Lasabuda, R. (n.d.). Pembangunan Wilayah Pesisir 

Dan Lautan Dalam Perspektif Negara 

Kepulauan Republik Indonesia. Jurnal Ilmiah 

Platax 1–2, 92–101. 

Oriana, Nindita, Isni Nurruhwati, Indah Riyantini,  

and L. P. S. Y. (2017). Kelimpahan 

Foraminifera Bentik Berdasarkan Komposisi 

Dinding Cangkang Di Perairan Pulau Tegal, 



Herison A, et al | Vol 19 No 2 Tahun 2019  

 

SPATIAL Journal of Geographical Studies |43  

 

Kabupaten Pesawaran, Provinsi Lampung. 

Jurnal Perikanan Dan Kelautan VIII, 1, 1–8. 

Pusat Studi Pariwisata Universitas Gadjah Mada 

(PUSPAR UGM). (2005). Potensi Objek 

Wisata (Online). Retrieved from 

https://puspar.ugm.ac.id/category/publikasi

/. 

Rahman, M. A. (2010). Application of GIS in 

ecotourism development : a case study in 

Sundarbans , Bangladesh. Search, (June), 1–

89. 

Rahmawati, Susi, Andri Irawan, Indarto Happy 

Supriyadi,  and M. H. A. (2014). Panduan 

Monitoring Padang Lamun. Edited by 

Malikusworo Hutomo and Anugerah Nontji. 

Jakarta: PT. Sarana Komunikasi Utama. 

Rahmayanti, Yunita Dwi,  and V. I. S. P. (2013). 

Dampak Keberadaan Objek Wisata Waduk 

Sermo Terhadap Perubahan Sosial Ekonomi 

Masyarakat Di Sermo, Kulon, Progo, Daerah 

Istemewa Yogyakarta. Jurnal Pendidikan 

Sosiologi 1, 1–15. 

Ramadhan, Syahru, Pindi Patana,  and Z. A. H. 

(2014). Analisis Kesesuaian Dan Daya 

Dukung Kawasan Wisata Pantai Cermin 

Kabupaten Serdang Bedagai. Jurnal 

Aquacoastmarine 5, 4, 31–43. Retrieved 

from https://doi.org/10.7498/aps/62.010302 

Ruhanen, L. (2019). The Prominence of Eco in 

Ecotourism Experiences: An Analysis of 

Post-Purchase Online Reviews. Journal of 

Hospitality and Tourism Management 39 

(October 2018), 110–16. Retrieved from 

https://doi.org/10.1016/j.jhtm.2019.03.006 

Soyusiawaty, Dewi, Rusydi Umar,  and R. M. 

(2007). Sistem Informasi Geografis Objek 

Wisata Propinsi Kepulauan Bangka Belitung 

Berbasis Web. Seminar Nasional Aplikasi 

Teknologi Informas, 17–22. 

TIES (The International Ecotourism Society). 

(2015). Retrieved from 

http://www.ecotourism.org/what-is-

ecotourism. 

Titaheluw, Syahnul Sardi,  and I. (2012). Status 

Terumbu Karang Dan Ikan Karang Di 

Perairan Sidodadi Dan Pulau Tegal Provinsi 

Lampung. Jurnal Aqua Hayati 9, 1, 1–11. 

Retrieved from 

https://doi.org/10.29239/j.agrikan.10.1.27-

33 

World Tourism Organization. (2018). Ecotourism 

and protected areas (Online). Retrieved 

from 

http://sdt.unwto.org/content/ecotourism-

and-protected-areas 

Yulianda, F. (2007). Ekowisata Bahari Sebagai 

Alternatif Pemanfaatan Sumberdaya Pesisir 

Berbasis Konservasi. Seminar Sain 

Departemen MSP, FPIK IPB. 

Yulisa, Eka Noerma, Yar Johan,  and D. H. (2016). 

Analisis Kesesuaian Dan Daya Dukung 

Ekowisata Pantai Kategori Rekreasi Pantai 

Laguna Desa Merpas Kabupaten Kaur. 

Jurnal Enggano 1, 1, 97–111. Retrieved from 

https://doi.org/10.31186/jenggano.1.1.97-

111 

 

 

 

 


